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Overview 

 

The Diamond Cut Software comes in two versions.  The DCForensics version (a professional version) is the 

superset platform of our audio software product family.  The DCArt (a commercial version) is a subset of the 

DCForensics platform.  You can find 15 day, fully functional demo versions of these products at the following links: 

 

Forensics Version (DCForensics10.6x):  https://www.diamondcut.com/st3/product/dcforensics10/ 

 

Commercial Version (DCArt10.6x):   https://www.diamondcut.com/st3/product/dcart10/ 

 

The demo links are shown in Red typeset within the product description area.   These demo version can be turned 

into permanent versions if you decide that you like them by purchasing serial numbers for the desired product on 

those same websites. 

 

 If you learn the basic concepts of the operation of either of these two programs, you will be in good shape to 

operate either one on a basic level.  This “Getting Started Guide” presented here is intended to teach the basic 

https://www.diamondcut.com/st3/product/dcforensics10/
https://www.diamondcut.com/st3/product/dcart10/
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program/process/flow and principles of operation that you will be using in your restoration/enhancement/analysis 

work. 

 

This Getting Started Guide document does not replace the complete Diamond Cut Software (670 page) user’s guide 

which can be found under the Diamond Cut Productions program group of your product.   

 

Note:  Everything you need to know to install the software, hook up your hardware and begin to use the program 

will be found in this “getting started” document.  This is must reading.  We think that you’ll find it easy and fun! 

 

Read through this section carefully and perform the steps indicated and you’ll have a perfectly working real time  

audio restoration workstation! 

Step One – Make Sure System Meets Our Requirements 

 

Most machines today are more than capable of handling extensive audio signal processing techniques.  Hard drives 

have also grown to a point, where you really have no limits on what you can do…except perhaps time.  As we’ve 

not yet developed time manipulation outside of the computer, let’s just deal with what you’ll need in the way of a 

PC.  Here are the minimum System Requirements: 

 

 Intel Pentium 4 or better (previewing large numbers of filters strung together in the Multi-Filter may 

require higher power processors.)  Faster CPU clock rates are better. Core i5 or better is recommended. 

 16 bit (or better) Stereo Sound Card with line level inputs.  Real time feed through requires a full 

duplex sound card that can record and play at the same time.*  Note: Sound card must use Windows 

DirectX or WDM drivers. 

 1024 Mbytes of memory (RAM) for XP, 2GB for Vista or Windows 7, Windows 8**, or Windows 10. 

 Windows XP with SP3 upgrade, ***  Windows Vista, Windows 7 or Windows 8 (32 or 64 bit), and 

Windows 10 

 Audio Source Material  

 A high quality Audio Delivery System (to interface whatever source recordings you have into your 

computer system) 

 A Hard Drive with enough space to accommodate your .wav files.  A formula is provided to calculate 

the space requirement but you should have about 2.5 Giga bytes free to make a full audio CD.  (The 

program itself only requires about 45 to 70 Mbytes of space, depending on the version.) 

 Mouse, Keyboard, and Color Monitor 

 A High Quality Set of Headphones (required for Forensics Audio work) 

 

* You now possess the state-of-the-art in technology for audio restoration, enhancement, audio measurement and 

forensics file surveillance and authentication.  If you haven’t yet replaced the sound card that came with your 

computer (which is probably the lowest quality audio component you own), consider purchasing a high-performance 

unit.  Your audio restoration results will only be as good as the weakest link in your audio chain allows.  Maybe 

that’s a good item to add to your “wish list”. 

** If your computer has more than the minimum required to run your OS adequately, further increases in the 

quantity of RAM will not appreciably speed up the DCArt10 / DC Forensics10 algorithms since they are almost 

totally limited by the processor.  Upgrading to a faster processor will allow the filters to run faster. 

Most DCArt10/DC Forensics10 algorithms use a single thread and will not be appreciably sped up by multi-core or 

multiprocessor CPUs.  

 

***This product uses DirectX and requires DirectX 9.0 or higher. 

Some older computers may require additional component installations. 

 

 

Step Two - Installation of the Product 
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Most users find this extremely easy. 

 

1. Download the demo software program installer from our website https://www.diamondcut.com/st3/product-

category/software/    

2. Install the program.  After the demo time period runs out, you can choose to purchase the software.  The demo 

version will convert to a fully registered license if you decide to make the purchase at the end to the demo 

period.  Each license is for one user on up to two computers. 

 

The software will be installed in a folder under “programs” called Diamond Cut Productions. Several demo .wav 

files are also supplied as part of the demonstration tutorials found in both the Help file and PDF version of the 

manual.   

During the installation process, you will be asked to approve the license agreement, and select an install location. 

After a few seconds of installation time, you’re ready to launch the program by clicking on the DCArt10 or 

Forensics10 Icons, depending on which program you have purchased. 

 

When DCArt10 or Forensics10 is first run you must choose your User Name and/or email address and enter it into 

the software.  You also will need to enter the Serial Number that was supplied to you when you purchased the 

product. Enter the serial number exactly as shown using only the numbers 0-9 and letters A-Z. 

 

The combination of your email and serial number is your unique key to DCArt10 or DC Forensics10; no other 

personal information is used.  

After you have entered your name and Serial Number, you must then register the program with Diamond Cut 

Productions. The registration process can be done automatically over the internet or via phone or email.  

 

If you choose automatic registration, DCArt10/DC Forensics10.xx will attempt to contact the servers at Diamond 

Cut Productions and automatically register your product. The registration process initiates our server to create a 

registration code and emails that code back to you. You will receive an email with the registration code; use this 

code in your software.  Save it for your records, should you ever need to re-install the product.  

 

Note 1: Diamond Cut Productions is the ONLY authorized source of registration codes, regardless of where you 

purchased your product.  

 

Note2: DCArt10 and DC Forensics10 require an email address, Serial Number and Registration Code from 

Diamond Cut Productions, Inc.  After you receive your Serial Number and have entered an email address, you will 

receive a registration code via email. Record those data somewhere for future reference.  The most common support 

question is “my hard-drive crashed and I just replaced it.  I have my serial number but I do not remember my user 

name.  Can you retrieve my user name from your server database for me?”  Of course, we can usually do that, but it 

will cause you an unnecessary delay.  Once you have a successful installation, you can print out these data from the 

Help/About Diamond Cut Audio Restoration Tools menu. 

 

Step Three - Configure Your DCArt10/DC Forensics10 Program 

 

DCArt10/Forensics10 does not require much configuration, but it does require that your sound card be installed and 

working properly. If you have more than one sound card in your system, make sure the one you wish to use has been 

selected in the Sound Card Selection screen (in the Edit/Preferences/Soundcard Menu).   

 

Next, check the Temp File Path under the Edit/Preferences/General 

Menu.  DCArt10/DC Forensics10 automatically assigns temporary file names for files that are being processed. You 

should set this temporary drive path to the disk drive that you wish to use for audio editing. This is usually the drive 

with the most free disk space. Keep in mind that high quality (44.1 kHz – 16 bit) Stereo recording consumes 10.5 

Mbyte of disk space per minute.  

Note that the Temp File Path should NOT be at the root of your hard drive. For example setting it to “C:/”  will not 

work, it should be set to a subdirectory.  
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Step Four – Connect Your Computer to Your Audio System 

 

Your sound card has both an input and an output.  The output is used when you play an audio file and the input is 

used when you record audio into the computer.   Refer to your sound card manual or the little icons on your 

soundcard to identify which jack is for output (playing back audio) and which is for input (recording audio).  Often, 

a small speaker or headphone icon represents the output jack. 

 

We first want to connect speakers to the output of your sound card so we can hear audio.  You probably already 

have speakers connected.  If you do, then fine.  Just leave them alone.  If not, you’ll need to connect the output of 

your sound card to either an amplifier or amplified speakers having line level inputs (-10 dBv). 

 

Note:  Your sound card records and plays audio at a certain established Voltage level.  This standard level is 

referred to as “Line Level”.  Just about all devices play or record at this exact audio level so they’re all compatible 

with each other.  CD players, Tape Recorders, Amplifiers, Receivers, VCRs, DAT machines, Mini discs and most 

other devices all play or record this standard “Line Level” signal amplitude.  This means you can plug your tape 

player output or other line level device directly into the input of your sound card since they both use the same signal 

level (amplitude). 

 

 
Wiring Things Up! 

 

Next, we need to connect a signal into the input of your sound card so that we can record this audio onto your 

computer’s hard drive.  If you are using a line level device, just plug it into the sound card “Line” level input using 

whatever adapter cable mates your player device (i.e., tape recorder) to the input jack on your sound card. 

 

Critical Note on Turntables - There are two common playback devices that are not line level and which can’t be 

plugged directly into your sound card line level input.  The first is a turntable with a magnetic phono cartridge.  A 

magnetic phono cartridge produces a signal that is much lower in amplitude than line level sensitivity.  Your sound 

card cannot use this signal as it is; it must be amplified up to the standard line level before it is applied to the line 

input of your sound card.     

 

If your turntable has a magnetic phono cartridge, you must use what is called a magnetic phono preamplifier as the 

first element of the signal path.  If you have a stereo system with an input jack on the back-labeled “Phono”, you 



 
 
 

5 
 

probably already have a magnetic phono preamp.  It’s in your stereo system.  Just leave your turntable connected to 

the “Phono-Input” of your stereo and connect a Line Level output of your stereo to the sound card input.  Many 

times, this line level output is marked as “Tape Out”.  Now, any audio (including your turntable) you can hear from 

your stereo system will be available to your computer for recording.  Another option to consider is the use of a “Flat 

Phono Preamplifier”.  Flat preamplifier front ends, when used in conjunction with the Diamond Cut Virtual Phono 

Preamplifier (VPP™) provides a high level of EQ curve flexibility as well improved sonic performance of your 

transfers.  For more information on this technique, you can download an Application Note from our website located 

at: http:/www.diamondcut.com 

 

Navigate to the Application Note section of the site and look for AN 8 titled “The New Way of Recording LPs”. 

 

Note: A more direct link to this Application Note is: http://www.diamondcut.com/AppNotes/TheNewWay.html 

 

If you don’t have a stereo system to connect your turntable to, or it’s in another room, you’ll need a stand-alone 

preamplifier.  These are not expensive and you can purchase one at:  https://www.diamondcut.com/st3/product/flat-

response-phono-preamp/ 

 

Again, this device takes the tiny signal from your turntable and amplifies it so that it’s now a standard Line Level 

signal that can be plugged directly into your sound card.  An application note describing its use can be found here: 

 
https://www.diamondcut.com/AppNotes/AN-13%20DCP-47K-F%20Flat%20Preamp%20Operating%20Instructions.pdf 

 

Note 1:  Low cost turntables utilizing Ceramic Phono Cartridges do not require a special pre-amplifier because their 

output signal levels are already at approximately line level. 

 

Note 2:  Be sure to connect the turntable-grounding wire (strap) to the chassis ground of your Phono Preamplifier or 

to the computer chassis itself to minimize ground loop induced hum. 

Another device that does not develop a standard Line Level signal is a microphone.  If you want to record from a 

“mic”, just plug it into the jack on your sound card that is labeled “Microphone”.  If you need to use this mic jack, 

again, refer to your sound card manual for specifics.   

 

Note 3: Some laptops have only two analog audio jacks.  One is always an earphone / audio output jack while the 

other is often labeled “mic”.  Many laptop computers allow you to convert the functionality of this “mic” input over 

to that of a “line” input via the sound system chipsets driver routine control panel.  Please refer to the manufacturer 

of the laptop for details on this mic/line level switchover functionality. 

 

In most cases, you’ll simply be taking the output of your source to the input of your sound card.  This is pretty easy 

to visualize since the computer is really acting like a familiar tape recorder with an input and an output.  Many 

audiophiles have very sophisticated and complicated audio systems that allow many different types of hookups.  

Therefore, there are many alternative methods for connecting your computer to a sound system in order to be able to 

use DCArt10/DC Forensics10.  Here are several methods: 

 

(NOTE:  Typical users will not have to use these or other complicated hookups – just supply an audio signal to the 

input of the sound card and listen to it on the output.) 

 

Method #1: Using a home stereo tape-monitoring loop 

 

1. Connect a stereophonic magnetic phono pickup system to an audio pre-amplifier with magnetic phono 

equalization inputs. 

2. Connect your line level sound card input to one of the pre-amplifier's tape recording outputs. 

3. Connect your line level sound card output to one of the pre-amplifiers tape monitoring inputs. 

 

Method #2: Using a DAT with digital (S/PDIF) inputs and outputs 

 

1. Connect a stereophonic magnetic phono pickup system to an audio pre-amplifier with magnetic phono 

equalization inputs. 

http://www.diamondcut.com/
http://www.diamondcut.com/AppNotes/TheNewWay.html
https://www.diamondcut.com/st3/product/flat-response-phono-preamp/
https://www.diamondcut.com/st3/product/flat-response-phono-preamp/
https://www.diamondcut.com/AppNotes/AN-13%20DCP-47K-F%20Flat%20Preamp%20Operating%20Instructions.pdf


 
 
 

6 
 

2. Connect the DAT machine analog output to a tape monitoring input on the pre-amplifier. 

3. Connect the DAT machine analog input to a tape output on the pre-amplifier. 

4. Connect the Digital Output of the DAT machine to the Digital Input of a "Digital-Only" sound card in your 

computer. 

5. Connect the Digital Input of the DAT machine to the Digital Output of the "Digital-Only" sound card. 

 

Method #3: Using a mixing board and Analog Sound card 

 

1. Connect a stereophonic magnetic phono pickup system to a magnetic audio pre-amplifier (these are 

available without all of the bells and whistles associated with a full-blown home audio pre-amplifier).  

2. Connect the Outputs of the magnetic pre-amplifier to two of the line level inputs on your mixing board (one 

input for each channel). 

3. Connect the line level outputs of the analog sound card to another pair of line level inputs on your mixing 

board. 

4. Connect your tape recorder (DAT or Reel-to-Reel or whatever) line level outputs to another pair of line 

level inputs on your mixing board. 

5. Connect any other input devices you may require into the remaining inputs of your mixing board. 

6. Connect the Main mixer output to your power amplification system. 

7. Connect the Monitor Outputs from your mixer to the line level input of your sound card. 

8. Connect the tape recorder line level input to the Stereophonic Headphones output jack on your mixing 

board. 

 

Warning: Method #3 is the most versatile method for setting up a small sound restoration lab.  However, because it 

is so versatile, feedback loops are easily created which can produce very annoying and potentially dangerous signal 

levels (to your ears, power amplifier and loudspeakers).   So you must be careful not to allow the output of a device 

to feedback into the same device when operating the mixing board.  Always check twice before raising a slider 

control on your mixing board utilizing this method.  

 

Troubleshooting: Generally, this is where we get calls from customers who experience one form of problem or 

another.  This is usually because most people don’t record onto their computer’s hard drive very often and they may 

not have their system set up for this type of application.  We’re happy to help, but before you call us… please read 

the next few paragraphs: 

 

1. Make sure you have the output of your audio source plugged directly to the “Line” input of your sound 

card.  Don’t use the Microphone (Mic) Input of your sound card for line level signals because it can cause 

clipping distortion. 

2. If you have a turntable, make sure that you are using either a stereo preamp or the “Tape Out” on your 

Stereo system in between the sound card and the turntable.  Your turntable cannot generate enough signal 

level on its own to make a good line level recording.  You’ll need the additional amplification to boost your 

turntables signal to be compatible with the “Line” input of your sound card.  

3. If you try to play or record and you get the message “Cannot play the specified format…etc.”  This is a 

message generated by Windows…not our product.  It is telling you that DCArt10/DC Forensics10 is trying 

to play a .wav file through a device that is not able to do this.  This could be a result of Windows having a 

modem listed as the primary device for playing .wav files…or some other non .wav device.  Check in your 

Start Menu/Control panel settings to make sure that your sound card is listed as the primary playback 

device.  Also, make sure DCArt10/DC Forensics10 is set correctly for your sound card under the 

Edit/Preferences/Soundcard menu. 

4. If you can hear audio playing through the speakers but the record VU meters are not jumping, then check 

your sound card’s mixer.  Many times, the recording mixer is turned down or muted.  Just click on the 

mixer (in many cases it’s a little yellow speaker icon located in your Windows Tray beside your clock), and 

go to Options/Properties and look for “Recording”.  Click on “Recording”, then click “OK” to select your 

input mixer so you can turn up or select your Line Level inputs. 

 

Important Note – also make sure your “Line” input is selected in this mixer – not your “Mic” input (unless 

you are attempting microphone based recording). 
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Step Five – Turn Screen Saver and Background Tasks Off 

 

In some cases when recording, if your screen saver or other background computer tasks automatically comes on, it 

may interrupt your recording or add glitches that you didn’t want.  It is always better to turn these functions off 

before recording. Though this is less of a problem with faster computers, most users will feel more secure if they 

turn off automatic backups, screen savers, etc.  This allows the computer resources to fully dedicate themselves to 

recording clean audio. 

Step Six - Choose your Operating Mode 

 
The software can be operated in either of two basic operational modes.  Choose your operating mode based on your 

personal preference.  Beginners will likely find that the Fast-Edit mode is easier to get oriented with since it works 

more like traditional audio editing programs.  More advanced users will likely switch to the Classic mode since this 

offers a fully optimized restoration environment.  You can quickly switch between these two modes of operation via 

the “One Click Edit Mode Switch” icon.  Just click on the icon and it will toggle between the two alternative editing 

modes.   

 

 
   

“One Click Edit Mode Switch” Icon 

 

 

Fast-Edit Mode 

 

The Fast-Edit (single file editing mode) mode operates much like a word processor where all editing is done on one 

file. The original file is not modified until a “Save” is performed. Fast-Edit mode maintains a separate history file 

representing the editing sequence and offers almost unlimited Undo capability.  The advantage of the Fast Edit’s 

Single file editing mode is its “greased lightning” speed, leaving you with more time for your domestic chores.  

Where editing examples are used in this manual in order to highlight the use of an editing or filtering sequence, the 

Classic Edit (Source and Destination) mode is utilized.   

 

In this Fast-Edit mode, you preview the processing results, and if not satisfactory, you can use the “Undo” feature 

found in the Edit menu.  Also, you can highlight a particular step in the Fast-Edit history in order to quickly jump 

back to a previous editing state.  The editing processes will be temporarily undone back to the selected point in the 

Edit History Monitor. If you want to permanently go back to a previous editing state you can simply double click on 

the last edit you want to delete in the Fast-Edit Window (display).  All editing done after that point will be removed 

and you can continue your editing session. The Delete function can also be found by clicking with the right mouse 

button.  Fast Edit temp files are maintained in the same directory as the source file and include elements of the 

original file name for ease of identification.  The Fast-Edit history file uses the extension of .ses.  Temporary files 

created by your Diamond Cut Software precede the extension with dctmpxx.  They are stored in the TempFiles 

directory and can have various file extensions such as .wav, .pkf, or .ses. 

 
Classic (Edit) Mode 

 

DCArt10/DC Forensics10 Classic (Edit) mode usually operates on files in a non-destructive manner. The Source 

and Destination mode (the Classic technique) involves the use of a “Source and Destination” set of files. When a file 

is processed with a DCArt10/DC Forensics10 filter or effect, the software reads the Source file, modifies it with the 

selected filter or effect, which then writes it to the Destination file. The main workspace of DCArt10/DC 

Forensics10 always has a Source and a Destination file in the Classic (Edit) mode. This mode of operation has a 

few important benefits: 
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1. The original source file is not modified, leaving it available for instant comparisons with the processed 

version. 

2. The original material can always be recovered if the results of processing are found to be unsatisfactory. 

3. Selected sections of the file can be reprocessed using different filter parameters or different filters entirely 

(refer to “Sync Files” mode).  

4. Every filter that is run yields a new file which can have yet another filter run thereon.  All of these 

intermediate files are always available so that the users can instantly go back one or more steps in the 

restoration process.  These files are all stored in the .wav format. 

 
The Source and Destination Workspace 

 

When you open a .wav file in DCArt10/DC Forensics Classic-Edit Mode, two workspaces will appear.  The top 

one, called the Source Workspace will display an envelope consisting of the program peaks of the .wav file just 

opened.  If you are using Peak files (a user preference), the entire waveform should be visible in the window. If you 

have peak files turned off, then the amount of the .wav file that will be displayed is determined by your preferences 

"display limit" settings.  Both settings can be found in the Edit/ Preferences/General section of the Edit Menu.  The 

display will consist of a black signal on a yellow background (depending on the user’s preference settings).  

 

The Destination Workspace just below the Source workspace will contain no waveform information initially, and 

will contain a gray background color.  Both of these two workspaces display amplitude on the Y-Axis (vertical) and 

time on the X-Axis (horizontal).  When you initially open a file, the entire file is displayed, and is periodically 

represented by a sample of the peak of the waveform envelope.   When you Zoom-in on a portion of the waveform, 

at some value of magnification, you will begin to see continuous waveforms, rather than impulse representations of 

your .wav file signal.  For more information regarding Zooming-In on a .wav file or Zooming-Out on a .wav file, 

please refer to the sections entitled "Zooming-In & Zooming-Out on portions of a .wav file".  Please note that the 

active workspace is always shown in yellow (the software default setting).   

 

If you are working with stereo .wav files, the workspace will display a pair of waveforms.  The top waveform in 

either of the workspaces represents the left channel while the bottom waveform represents the right channel.  If the 

signal is monophonic, only one waveform will be seen in the workspace(s).  

 

At the top of the DCArt10/Forensics10 screen is a Title bar, which contains the name of the opened Source .wav 

file.  At the bottom of the DCArt10/Forensics10 screen and on the right side, you will see five little boxes.  The first 

shows the Mode in which the file was recorded or processed (“Stereo” or “Mono”) followed by the Sample Rate that 

was used to create the file and then the Bit Depth.  The fourth box give the total running time of the Source .wav file 

and the final box shows the space remaining on the hard drive being used. 

 

After a .wav file has been processed by one of the functions under the Filter command, the output of that file will be 

sampled just like the Source file and displayed in the Destination workspace just below the Source workspace.  It 

will become highlighted in yellow just following the completion of a processing session. 

 

At the bottom of each of the two workspaces, you will see several time displays.  Each display is indicated in 

Minutes: Seconds: Milliseconds.  The time display on the left side of the workspaces indicates the starting time of 

the portion of the .wav file being displayed in the particular workspace.  The time display on the right side of the 

two workspaces indicates the ending time of the displayed portion of the highlighted .wav file.  When a file is 

initially opened, the display on the left will indicate 00: 00: 00. The right display will indicate the total time duration 

of the opened .wav file.  If you use the Zoom function, the left display will now display the start time of the 

highlighted 

Zoom-In portion of the .wav file.  The right time display will indicate the end-time of the highlighted Zoomed-In 

portion of the .wav file.  The total time duration of the Zoomed-In highlighted portion of the .wav file will be 

displayed on the status bar located below the workspaces.  

 

At the right hand side of each of the two workspaces, you will see two vertically oriented slider controls next to one 

another.  These are useful for viewing details in a selected portion of a waveform which has been Zoomed-In on.  



 
 
 

9 
 

For example, there may be a small transient that you want to see in more detail that is riding on top of a much larger 

waveform.  The control on the farthest right is the “Display Gain” control.  Using your mouse, you can move this 

control up and down in order to change the display gain. Moving it downwards will increase the gain of the time 

display.  This will cause the waveform to appear larger on your screen (you can also adjust the Display Gain using 

your mouse scroll wheel). However, it may get so large as to move the portion of the waveform in which you are 

interested off of the top or the bottom of the display screen.  The control just to the left of the gain control is the 

“Offset” control; this is used to move the entire portion of the waveform in which you are interested back into view.  

You should experiment with these controls a few times to get a feel for how they behave, and then you will begin to 

understand their usefulness.   

 

At the bottom of each workspace, you will see the “Time Axis Scroll-bar”.   This control is also operated by the left 

mouse button, and is used to move the “Play Pointer” to various locations within the display workspace. Sometimes, 

there can be a few seconds of delay when using this slider, so be patient as it performs the calculations to keep up 

with your commands.  When you are Zoomed-In on a portion of a file, the slider control can be used to move the 

display start-point within the highlighted field using either the slider with your mouse, or by using the arrow controls 

which are located at each end of the slider.  The Time Axis Scroll-bar position is always relative to the entire file 

length, no matter how zoomed-in on a particular waveform you may be. Clicking on the right arrow button will 

move the waveform to the left of the workspace 1/10th of the overall display length and clicking on the left-hand 

arrow button will do the same thing, only moving the file in the opposite direction.  If you click on the Scroll-bar 

(not the slider control itself), the waveform will move one full frame to the left each time you click.   

 

Note 1: The Time Axis Scroll-bar is inactive when you are fully zoomed-out. 

 

Note 2:  If you are not using Peak Files, then the software only reads the first few Megabytes of a .wav file for the 

initial display.  No .wav file processing operations are adversely affected by this action. Portions of your .wav file 

not shown on the display can still be played, filtered and operated on just as if they were displayed.  To set the size 

of the waveform that will be displayed, use the Preferences dialog box (found under the edit menu) and increase the 

"Display Length Limit" to the size of the file you wish to be displayed.  Keep in mind that the larger the display size, 

the longer it will take to initially open a .wav file. We recommend the use of Peak Files for faster future displays of 

the .wav file data. 

 

Note 3:  The Destination Workspace can be converted into an Audio Spectrogram time synced to the Source 

Workspace.  Zooming in and out of either time or spectrogram view remain synchronized. Please refer to the 

appropriate section of the manual for details on the operation of the Audio Spectrograph/Spectrogram. 

 

Note 4:  How to Choose Your Mode – To switch between Classic-Editing and Fast-Editing mode is fairly simple.  

If you start with one and decide you want to try the other one, you can simply go to the Edit Menu and click on 

Preferences and the General Tab.  There you will see a check box that enables Fast Edit Mode.    You then need to 

exit the program and re-run it for the changes to take place or you need to close any open file and then re-open it for 

the new mode to be invoked.  Alternatively, you can simply click on the “One Click Switch” icon which toggles 

back and forth between the two editing modes. 

 

Step Seven – Testing Your System 

 

By now you should have installed the software and connected your speakers to the sound card output and some 

audio playback device (such as a tape player) to the sound card input.  It’s time to make sure your efforts have borne 

fruit.   

 

The first thing we’re going to do is run the DCArt10/DC Forensics10 program.  Do this by double clicking the new 

DCArt10 or the DC Forensics10 icon on your desktop.  Put away the tips screen and click on File/Open Source.  

You’ll now see a familiar Windows file selector box.  Navigate to C:/program files/Diamond Cut 

Productions/DCArt10/Wavefiles (or wherever else you chose to install the program).  If you are using Forensics10, 

the demo files are located as shortcuts in the Start menu.  Open the file called Demo1 (Getting Started Demo can be 
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found under the Open Demo Wavefiles).  This is a standard .wav file and was included with the program.  We’ll 

actually clean up this file in the next section, but for now we just want to play it. 

Once the file is selected, it will open in the program and you’ll see the graphic drawing of the audio waveform on 

your display.  It will look something like this: 

 

 
 

A Monophonic File is opened 

The small band of waveforms above the main waveform is your waveform overview display.  It will show you 

where you are zoomed-in (on the main file) with respect to the overall file via a highlight.  Note the zoom-in and 

zoom-out icons near the left-hand side of the waveform overview display.  You can drag the highlighted area left 

and right and that action will be reflected in the primary waveform display below. 

Notice all the nice icons at the top of the display.  If you move your mouse over any one of them and leave it there 

for a second, a little box will open telling you what that icon does.  To play our file, we need to find the little icon 

that looks like a right pointing triangle.  This is the standard symbol for “play” that you’ll find on any tape deck.  

Click on this icon and you should hear audio and see the cursor move.  

 

 

 

 
 

The Diamond Cut Play Toolbar 

Note:  If you aren’t getting audio at this point, check out our Troubleshooting steps found later in the user’s manual. 

 

Let the audio play to the end of the file and it will stop automatically and reset itself so you can play it again.  Let’s 

play it again using a keyboard shortcut.  Shortcuts are simply keys on your keyboard that perform a function without 

having to use the mouse.  Power users love shortcuts and the Play shortcut is the easiest of all.  Just hit the spacebar 

now and the audio starts playing.  Hit the spacebar again to stop the audio from playing.  Easy, isn’t it?  Many 

beginners like to spend hours doing this, but let’s move on to test the recording capability of your system. 

 

For our recording test, we’re going to assume you have a tape recorder connected to the input of your sound card.  A 

CD player or even a turntable with a preamp uses exactly the same process, so just make sure you’re hooked up 

correctly. 

 

To record, start your tape recorder playing a pre-recorded tape (or start playing an LP, etc.).  You should hear the 

audio coming from your speakers.  Now click the red Record button on the toolbar in DCArt10 / DC Forensics.  A 

nice record screen comes up which looks like this: 
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The DC Forensics10 Record Window 

This screen will allow you to set the recording parameters and make sure the recording is happening correctly.  Let’s 

start by making sure we are set to record a stereo file at 44.1 kHz, 16 bit.  Just use the drop down boxes to select 

these parameters.  Note the Recording Device box.  Your sound card should be listed here.  If not, drop the box 

down and choose the sound card that has the audio being fed to it.  If you click on the “Set Levels” button, 

something like the following drop-down will appear which will allow you access to the Windows Mixer controls. 

 

 
 

Windows Sound Card Mixer Control 

 

Now click the Pause button in the Record Window.  This puts the program into what is called Record/Pause mode.  

The VU meters on the left should now start dancing as the program is actually seeing the audio from your tape 

recorder.   

 

If those meters are dancing, adjust the input level until they are reasonable (not too high or clipping and not too low) 

and you are now done with testing your installation.  Click “Stop”, and then click “Close”.  Answer “yes” when the 

program asks if you want to discard this recording.  You now have a perfectly working audio restoration workstation 

and you can go on to the next section where we’ll teach you to use this powerful tool. 
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If you found that your meters didn’t jump when you hit the Pause button, the problem is very likely caused by your 

sound card being set to the Mic input and not the Line Level input.  Full troubleshooting help is included later in this 

manual, but this common problem is easily and permanently solved by double clicking the little yellow speaker icon 

in your Window tray – just to the left of the clock on the bottom of your screen.  Now choose Options and then 

Properties.  Click the record button and then click OK.  Now click the check box under Line Input and your meters 

will start to jump in DCArt10/DC Forensics10 indicating that all is now well.  You just turned on the Line Level 

input – which is where our audio is, after all.   

 

Now that your system has been installed and checked, it’s time to get to the software and perform an actual 

restoration project.  

Step By Step Guides 

 

In this section, we’re going to take you by the hand and lead you through some complete examples of typical 

restoration projects.  You’ll remove noise and “sweeten” the audio.  When you are done, you’ll be licensed to drive 

the product yourself without training wheels. 

 

This entire training process will take you about 15 minutes and will give you all the basics you need to know to use 

the program.  Please follow along step by step thru the first three examples – Super Easy, Easy and Advanced 

Record Restoration.  If you are a Forensics audio user, please go thru all three Step By Step Guides.  In these 

Guides, we’ll tell you exactly what to do and even explain why it is you are doing these things.  It’s important that 

you follow along exactly as one step builds upon the next.    

 

Note:  The actions in this section of the user’s guide that you are expected to take are highlighted in Bold Italics.   

Let’s get started! 

 

Super Easy Record Restoration - - - Step By Step Guide 
 

If you are new to audio restoration and feel a bit intimidated with the large number of filters and tools in DCArt10, 

then EZ Clean™ is for you.  Our first guide is designed to get you going almost instantly.  The EZ-Clean™ filter 

will remove clicks, pops, hiss and other surface noise from music recording almost instantly.  Here we go. 

 

First, we need to run the program.  If it’s not already up, just double click the icon on your desktop to start it.  

DCArt10/DC Forensics10 starts with a tip screen, which offers quick suggestions as to how to use the program.  

You can disable this by clicking on the check box in this screen.   

 

In this guide, we’re going to use the Classic Source/Destination mode to run you thru the software.   You can choose 

this mode by clicking on Edit/Preferences in the program.  Make sure the check box that is labeled Enable Fast Edit 

is unchecked.  If you just unchecked it, close and restart the program to get going in Classic mode. 

 

Next, open the Demo1 .wav file the way we did in the testing section above.   

 

Listen to this file by either clicking the Play button or hitting the spacebar – it’s full of clicks, hiss, low frequency 

noise, etc.  It’s a mess.   Stop the playback when you’re done listening. 

 

And, now let’s get to the fun part.  Click the Filter Menu and choose EZ-Clean.  The filter looks like this: 
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EZ Clean™ Is Almost Too Easy 

Notice that there are only three sliders, one for scratches or clicks, one for crackle (or small clicks) and another for 

hiss or other continuous type noises.  We are simply going to listen to the audio and move these three sliders as we 

listen.   

 

Move each slider to approximately the settings shown above.  We don’t need to be perfectly accurate, just set them 

similar to what you see.  When you move these sliders to the left, the filtering becomes more aggressive.  Now click 

the Preview button.  You’ll start to hear the audio.  

 

Listen for a second or two.  Now click the checkbox labeled Bypass.  This “bypasses” the filter and stops the 

filtering.  You are now hearing the original music without the filters in place.  Note the large amount of clicks and 

hiss.   

 

Uncheck the bypass box to start filtering again.  What a relief!  That’s much better isn’t it?  But, you can do better 

yet.   Move the Hiss slider a bit farther to the left until you remove more of the random noise.   Remember, moving 

the sliders to the left, makes them filter more, so just slide them until you are happy with the result.  If you move 

the controls too far to the left, you may introduce digital artifacts and/or distortion into the signal.  You must strike a 

balance between noise reduction and artifact/distortion creation with these tools. 

 

Now note the Hum filter on the EZ-Clean screen.  If you live in the US, you’ll check the 60 Hz box to remove 

power line hum.  If you live in Europe, you’ll check the 50 Hz box.  There are many other tools to remove larger 

amounts of hum in DCArt10, but this one is quick and easy. 

 

Now, stop the preview by clicking on the Cancel Button in the Progress- box.  Click on “Run Filter” and you now 

have a destination file that is fully cleaned!   Could this possibly be any easier? 

 

Please continue on with the Easy Record Restoration guide below.  It starts your education on how to use individual 

tools and goes into more depth on the overall concept of the Diamond Cut software.   

 

Easy Record Restoration Step By Step Guide 

 

Since EZ-Clean™ is so easy to use, you don’t really get a feel for the overall software program and its depth of 

capability.  This guide assumes you will use individual tools and will perform a restoration in a series of steps.   

 

You will be working with DCArt10/DC Forensics10 by choosing filters to apply to your audio .wav file.  Some of 

the filters remove noise and others enhance the audio though they are all referred to in this guide as filters.  You 

choose a filter by identifying the type of noise you want to remove and then selecting the filter that removes that 

type of noise.  Make sense so far, right?  In just about every case, when clicks and pops are present, we want to 
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remove them first.  Trust us, this is the right first step whenever you get ticks, clicks and pops on records or other 

recordings (called impulse noise). 

 

To remove the clicks, we’ll choose the EZ-Impulse™ filter.  Clicks are short noise impulses so it makes sense to use 

this filter.  To choose the filter, click on the Filter menu item and choose EZ-Impulse Noise.  You’ll see the filter 

open like this: 

 

 

The EZ-Impulse Noise™ Filter Appears 

Note that the filter takes up only a portion of the screen.  You can still see part of the waveform and all the menus 

and icons.  You can move this filter window around on your screen and position it wherever you want.  Just grab the 

title bar at the top of the filter window and drag it around.  Try it now. 

 

Now let’s focus on the filter itself.  Just about EVERY filter in DCArt10/DC Forensics10 will work the way this one 

does.  Once you learn this particular filter, you’ll be able to use all of them!  Because of this, we’re going to cover 

this filter in great detail.  Be sure and follow along. 

 

 

The EZ-Impulse Noise™ Filter 

In the filter window, you will see several features.  First, you’ll notice sliders that control various filter parameters.  

These sliders can be adjusted while you listen to the audio so you will instantly hear the result of any changes you 

make.  Our sliders in this example are labeled Scratch, Crackle and Narrow Crackle in this filter. 
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Next, you’ll have Radio buttons that control other aspects of the filters.  Again, you can usually change them while 

listening, so you’ll hear the results instantly.  The Radio buttons in the EZ-Impulse filter are Bypass, Big Clicks and 

Solo/Brass.  The EZ-Impulse filter allows you to change the Bypass and Solo/Brass buttons while previewing, but 

not the “Big Clicks” button.  You can only change that one prior to Previewing. 

In every filter or effect, you will have a Preview button.  This is the most important button here.  This button will 

start the audio playing while the filter is processing it.  You will hear the results of the filter instantly.  This makes 

for easy adjustment of the filters.  The Preview button allows you to adjust any/all filters before actually running the 

filter on the file (the “Run Filter” button). 

Also in every filter, you will have a “Bypass” checkbox.  This takes the filter in and out of the audio stream 

instantly.  When you listen to a filter being applied by the Preview button, you may want to be able to compare the 

processed audio to the original audio.  Clicking this checkbox will bypass the filter and you’ll be hearing the original 

audio.  Un-checking it will instantly put the filter back into the signal path.  This way, you can “fine tune” even 

subtle nuances in the audio signal with DCArt10/DC Forensics10. 

 

Lastly, every filter will have controls for Presets.  A preset is a saved group of settings for this filter.  Go ahead and 

drop down the Preset box now – it’s the white box at the bottom of the filter.  Click on some of the presets and 

watch the sliders as they move to good starting points for common tasks.  You can tell a lot by looking at the name 

of the presets.  Now select the preset labeled Default.  This one is already set up with good settings for our 

Demo1.wav file.  Every filter will also have a Save and Delete button that allows you to save your own presets 

under any name you want – and delete them too! 

 

You’re probably ready to try this filter by now, but there is one more thing that is common to each filter that you 

should know.  Hit F1 now on your keyboard.  Notice that our online Help comes up with information on this 

specific filter.  This context sensitive help is available for each and every filter. 

 

Put the Help screen away and let’s clean some audio.  If you’ve already been listening to this filter, then shame on 

you for jumping ahead.  Simon has not said click the Preview button yet.  As punishment, please go back to page 

one of this manual and start reading again.  We’ll wait for you here. 

 

Welcome back.  Now let’s get started by clicking the button labeled Preview.  You will hear the audio as it is being 

filtered.  You will still hear the low frequency rumble and the hiss, but the clicks should be gone.  Let it preview all 

the way to the end of the file.  Notice that once it reaches the end, it will automatically start over at the beginning.  

This is called Looping and is automatic when you are previewing with a filter (though it can be turned off in the 

Edit/Preferences screen). 

 

Let’s just confirm that the clicks are gone.  To do this, check the Bypass box in the filter while it is still previewing.  

Now the filter is bypassed and the clicks will once again be audible.  Listen for a while and then uncheck the 

Bypass box.  Now the filter is again doing its job and the clicks are no longer heard.  

  

It’s time to learn how to adjust a filter.  While you are previewing, move the three sliders to the bottom.  This makes 

the filter less aggressive and it will filter less.  Notice that the clicks return as the sliders are moved down.  Moving 

the sliders upwards results in more of the clicks being removed from the file.  All of the filters work this way – you 

just adjust them while you listen.  As you might expect, if you move them too far up you’ll make the filter(s) too 

aggressive and you’ll get distorted, stuttering or otherwise bad audio – just move them up enough to get the desired 

result.  Set them all to 50.  The “Scratch” control is adjusted by the user to attenuate large impulses. The “Crackle” 

control is for medium sized crackle and the “Narrow Crackle” control is used to attenuate smaller impulses.  

“Solo/Brass” should be turned on when dealing with up-front vocals or brass instruments like trumpets or 

trombones. 

 

Now click on Cancel in the Progress window seen here: 
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Monitor your Progress 

This stops the preview from playing.  By Previewing, we have adjusted the filter and confirmed that it is doing its 

job.  The next step is to click on the “Run Filter” button.  This takes the filter just as you have set it and applies it to 

the demo1.wav file and creates a new file in the lower window.  This new file has been run through the filter and has 

the clicks removed. At this point, click on Close in the EZ-Impulse filter window since we’re now done with it. 

Look at the two waveforms.  The top one is called the Source.  This is where we normally work on a file, preview 

filters, etc.  The bottom is called the Destination and is the result of our filtering efforts.  You can play either one by 

clicking in the respective window which will highlight that window.  Then, click the “Play” button  (or the spacebar)  

to hear either the source file or the destination file.  You have not changed your original (source) file at all – rather 

we’ve created a new cleaned up version (the one found in the destination window). 

Now it’s time to remove that rumble sound, but how can we do that if we work on the Source window and we really 

want to remove the rumble from the semi-clean file in the Destination window?  The answer is a little command 

under the File menu called Make Destination the Source.  This moves the file in the bottom window up to the top 

where we can work on it.  Click on File/Make Destination the Source now. 

 

A “Save As” box will pop up and suggest a new name for this file; just click on Save to accept it. 

 

Note: DCArt10 & DCForensics10 will automatically assign sequential names to new files.  While you’re new to the 

program, always just accept its recommendation as to file names. 

 

Now we are ready to remove that low frequency rumble.  To do that, we’ll choose the High Pass filter (an IIR type).  

Click on Filter/High Pass now.  (To get there, go to the Filter Menu\LP BP HP Filters and then select the “High 

Pass” filter.)  A high pass filter will remove all frequencies below a certain value and allow all higher frequencies to 

pass.    Drop the Preset box and select the preset called “Demo audio Wave file de-rumble”.  It will look something 

like this: 

 

 

The Highpass Filter 

We’ll start to go a bit quicker now since you already know what most of the buttons and controls do on this filter.  

To find out specific info on this filter, don’t forget you can call for help by pressing the F1 key.  We are going to 

free you now to preview and play with this filter on your own, but when you’re done, return it to these settings by 

once again clicking on the demo Wave file preset.  Run the filter when you are ready. 

 

You now have removed two of the annoying noise types in this file.  First, we rid ourselves of the clicks and pops, 

and then we removed the rumble.  Now it’s time to get rid of that loud hiss sound.  First, remember to move our 

Destination file up to the Source window.   



 
 
 

17 
 

 

Now click on the Filter menu and select the Continuous Noise Filter.  This filter is perfect for reducing hiss and 

other types of continuous noise.  Also, click on the View menu and make sure you have the Time Display checked 

at this time.  The Time Display box shows you various timing calculations with the program and will come in 

handy, as you will see.  Your screen should look something like this: 

 
 

The Continuous Noise Filter is Awake 

The Continuous Noise filter is one of the coolest filters in the whole program so follow along carefully here.  This 

filter will remove just about any continuous noise in a program, but it needs you to give it a sample of this noise.  

Once it is able to examine the noise, it will be able to seek it out and attenuate it.  Play the file now using the Play 

button at the top and listen carefully to the first couple of seconds.  You will hear an area right at the beginning 

which contains only the noise and without any of the good audio.  That’s a great spot from which to grab a sample 

of the noise.  To do this, we need to click and drag with our mouse to select this area of the file.  The narrow area 

near the left-hand margin in the illustration above is the area we want to select.   Just left click about ½ inch from the 

left edge and, while holding down the left mouse button, drag all the way left.  Let the mouse button go and you will 

see that area highlighted in bright yellow.  This is the area you have selected.  Move the mouse pointer over either 

edge of the selected area and the pointer will turn into a Left/Right indicator.  Click and drag as necessary to select 

an area from the beginning of the file that is about .5 seconds long.  Use the “Span=” display in the timer window 

to confirm that your selection is around ½ second long. 

 

Now hit the spacebar.  You’ll play only the selected area.  It’ll be quick.  This allows you to audition a selected area 

to make sure you are really working on the correct area (does not contain silence or desired signal).  You should 

only hear the hissing noise.  Again, your selected area should only include noise and no music. 

 

Now, it’s time for the fun part.  You will like this.  Hit the Sample Noise button in the Filter window.  The filter 

will analyze the noise sample and then display the frequency characteristics of the noise in red.  The blue line is the 

filter that has been designed to attenuate this noise.  Notice how they track with each other.   Yours should look 

something like this: 
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The Continuous Noise Filter Does its Job 

If you have jumped ahead again and clicked on Preview, there will be no lunch for you today.  First, we’ve got to 

explain those little blue dots on the filter line.  Notice how the blue line is above the red noise sample?  The higher 

the blue filter line, the more filtering occurs at that frequency.   The blue dots are called Control Points and allow 

you to adjust the amount of filtering for frequency components in the vicinity of the control point manually.  We’re 

going to do that in a second, but realize that the Help file contains the complete information on this filter. 

 

Before we click on Preview, we need to again select the whole file so we’ll hear the whole thing and not just our ½ 

second noise sample that is now selected.  To select the entire file, just double click anywhere in the waveform 

display area.  Notice how the entire thing gets highlighted in yellow.  Now, go ahead and click on Preview.   

 

Listen to the audio.  The clicks are gone.  The rumble is gone and now the hiss is gone too!  Well, not quite.  You 

can still hear a bit of hiss can’t you?  While Previewing, click the bypass button a few times to take the filter in an 

out of the signal path.  Yes, the hiss is reduced, but there is still some of it there.  Let’s adjust this filter to get rid of 

all of the hiss. 

 

Make sure your bypass button is NOT checked and make sure you are previewing the audio.  Now grab the 2
nd

 

control point from the right side and move it up a bit as shown below. 
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Tackling the remaining Hiss 

It’s like magic, isn’t it?  The hiss almost completely goes away because you told the filter to be a bit more 

aggressive on the high frequencies.    Remember, moving the blue line upwards makes it filter more.  Now stop the 

preview, click on Run filter, and close the Continuous Noise filter.  If you like that filter setting, you can click on 

the “Save” button and then name it as a preset so that it can be recalled later. 

 

You now have a Destination file that is completely restored.  To finish, click on File/Make Destination the Source, 

accept the file name and you’re done.  This file is the completed version and all others can be deleted or saved if 

you want each processing step before and after the saved file.  You can now exit the program or close the files using 

the commands under the File Menu. 

What you’ve learned in this section 

In this quick Step by Step guide, you’ve learned how to launch the program, how to select filters, how to preview 

them, how to bypass them, how to load and save presets, what are Source and Destination files, how to apply 

multiple filters to a single file, how various filters work and much more.  Not bad for a few minutes!  Next, we’ll 

give you a more advanced Step by Step procedure in which you get to use the most powerful feature of 

DCArt10/DC Forensics10, the Multi-Filter. 

Advanced Record Restoration Step-By-Step Guide 

 

You learned a lot in the last Step-by-Step Guide, so let’s continue by restoring this same file using a completely 

different approach.  This will show you the flexibility and power of DCArt10/DC Forensics10 and will introduce 

you to our powerful Multi-Filter.  Also, we will perform this advanced restoration in a Step-by-Step fashion using 

our new Fast Edit Single Screen mode.  We’ll assume you’ve done the Basic Guide above and are therefore 

comfortable with the basic functions of the program so we will take this at a little faster pace.  As before, the actions 

you are expected to perform will be in Bold type.  Let’s get started! 

 

First, we want to make sure that you are in Fast Edit mode.  To do this, click on Edit/Preferences and make sure the 

box labeled Enable Fast Edit is checked (under the “General” tab).   If it’s not already checked, put a check mark 

in the box by clicking it.  Now close the program and then restart it.   The operational mode change will take effect 

when you start the program.   
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Remember, Fast Edit mode is a single screen mode of operation with no Source or Destination file window.  This 

mode of operation has the advantage of allowing almost instant cuts, pastes and copies on even very large files.  It 

also may be more familiar to users of traditional audio editing programs.  You can change from Fast Edit to Classic 

Mode anytime you want. 

 

Next, we want to enable the Fast Edit History box by clicking on View and then checking “Fast Edit History”.  

This will open your History box.  This box will show you everything that you do with this file and in the order that 

you do it.  It also allows you to return to an earlier state of the file quickly and easily.   

 

Now open the Demo1.wav file in the same way we did before.  Select an area near the center of the file using a 

mouse click and drag.  Your screen should now look similar to this: 

 

 

A Highlighted Section in Fast-Edit Mode 

Let’s cut out the highlighted area.  Just click on Edit and then Cut.  Boom! It’s gone!  Fast Edit mode is called that 

because it’s FAST.   You will now have two entries in your History window – the top one is for the original file as 

opened, and the second one is for the version you now see in front of you which is somewhat shorter.   

 

Click on the first entry in the Fast-Edit History window now.  The original file instantly comes back!  Did we say 

this thing was fast?  Everything you do will show up in the history window and you can bounce around your various 

versions of a file at will.  Click on the first and then second entries a few times to confirm this and then right click 

on the second entry and choose “Delete”.  You just deleted the cut-up version and we’re back to the original file. 

 

Now click on the Filter Menu and choose Multi-Filter.  In order to select the entire file for processing, double-

click anywhere in the waveform display or left-click and drag to select a segment of the file.  Notice how 

DCArt10/DC Forensics10 allows you to select an area or the entire file while the filter windows are open.  This is a 

very handy feature. 

 

The Multi-Filter is one of the most powerful features contained within the DCArt10/DC Forensics10 software 

products.  It allows you to string together many filters and then to preview or apply them sequentially or all at once 

to your file.  This saves a lot of time and makes it possible for users to create some incredibly sophisticated filter 

setups.   

 

Notice that the Multi-Filter has an input on the left side and an output on the right side.  Between the input and 

output is a signal path.  You can drag any filter (or multiple instances of the same filter) that you want into this 

signal path.  At this time, remove any filters that are in the signal path by clicking on them and dragging them out 

of the signal path.   

 

Remember when we went through the Basic Step by Step guide (above), we used three filters: the EZ-Impulse™ 

Noise filter for clicks, the High Pass filter for rumble and the Continuous Noise filter for the hiss.  Drag these three 

filters into the signal path with the EZ Impulse filter on the left side followed by the High Pass filter in the middle 
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and then the Continuous Noise filter on the rightmost side.  Now double click on the EZ-Impulse filter icon in the 

signal path of the Multi-Filter.  Your screen should look something like this: 

 

 

Working with the Multi-Filter 

To open the individual settings for any filter in the Multi-Filter signal path, just double click on that filter and create 

your settings.  For the Expert Impulse filter, drop the preset box and choose “Demo Audio Wave file De-click”.  

You could preview and adjust while listening here, of course, but we’ve already got some good settings available as 

a preset.  Close the Expert Impulse filter window. 

 

Now Double click on the High pass filter and select the “Demo Audio Wave file De-Rumble” preset.  Close the 

High Pass filter window when done. 

 

Lastly, open the Continuous Noise filter and choose the “Demo Audio Wave file DeNoise” preset.  Close the 

window.  We used these presets only because they are available.  You can always choose any preset or you can set 

the filters yourself by just previewing as we did in the Basic Step by Step guide.   

 

Note:  Each individual filter can be previewed even in the Multi-Filter. 

 

Now we have three filters strung together.  Click the Preview button in the Multi-Filter window.  You will hear the 

audio being filtered by all three of these filters.  Click the Bypass button a few times to marvel at what is happening 

here.  Feel free to giggle and then cancel the preview. 

 

Now we’re going to add a fourth filter.  Drag the Paragraphic EQ icon into the signal path and put it last in line 

(on the rightmost side).  Double click the Paragraphic EQ icon to open its adjustment window.  Now again click 

on the Multi-Filter Preview button.  You may have to move the Paragraphic filter window out of the way to access 

this button.  You are now hearing the audio filtered thru 4 filters.  Make sure the Bypass button is not checked.  

While the preview is happening, find the blue control point in the Paragraphic EQ that is close to 110 Hz.  You can 

see this on the horizontal scale on the bottom of the EQ adjustment area.  Move this up to increase the bass 

frequencies in our old recording.  The more you move it up, the more low frequencies you get.  It should look 

something like this: 
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Using the Paragraphic EQ 

You should notice that you are applying all four filters at once and you are adjusting one of them.  The results of 

your adjustments are instantly heard while all the filters are being applied.  Cancel the preview, run the filter, and 

“Save Source As” the file.  Fast Edit mode requires that you save files when you are done. 

 

What you’ve learned in this Advanced Step-by-Step Guide - - -  

 

You now know how to choose and use Fast Edit Mode, how to bring up and use the Multi-Filter, and how to 

Preview and adjust filters (or effects) while using the Multi-Filter.    

Forensic Audio Step-by-Step Guide (DC Forensics10.xx Only) 

 

If you are a new user of DC Forensics10, please go through the Basic and Advanced record restoration guides first.  

We know you won’t be restoring records with DC Forensics10, but these guides provide an excellent introduction to 

the overall flow of the Diamond Cut software programs.  We’ll assume you have that basic knowledge in 

preparation for this Forensic Guide tutorial.  As before, the specific steps for you to perform are in Bold. 

 

To get started, run DC Forensics10 and put it in Classic (Source/Destination) mode.  Now open the file called 

Forensicdemo.wav.  Forensics version demo files can be found on the Start Menu. 

 

Play this file.  Like a lot of Forensic audio files, the signal to noise ratio is very poor (a low ratio).  The noise is 

much louder than the voice and this makes it difficult to understand what is being said.  The speech is masked by a 

loud buzz and has a high frequency and a low frequency noise throughout the piece.  As always we start by listening 

so that we can identify the noise components that make up our problem. 

 

It’s easy to hear in this file that we will need multiple filters to clean this thing up.  Therefore, let’s use the Multi-

Filter.  Click on Filter/Multi-Filter and bring it up and clear out any filters that are in the signal path.  The file 

contains a loud Buzz that almost overwhelms the good audio.   To remove the hum and buzz, we will use the 

Harmonic Reject Filter.  It’s called this since hum and buzz are rich in harmonics and this filter can remove them.  

We’ll need one of these filters for sure but don’t put it in the Multi-Filter yet. 

 

Next, listen again.  There are other noises in this piece that you probably can’t easily identify by listening.  

However, we don’t only have to listen to the audio, we can also see it.  Click on View and then choose the 

Spectrum Analyzer.  Set the Spectrum Analyzer to a resolution of 5.38 Hz and 8192 FFT size.  Now click on Play 

on the toolbar and you’ll see the audio as well as hear it.  After listening for a few seconds, hit the spacebar to stop 

the playback.  The Spectrum Analyzer continues to show you the frequency spectrum of the audio.  Notice that there 

are some “spikes” of audio in here.  One, for example, is at around 950 Hz.  You can click on any spot in the display 

and the Spectrum Analyzer will show you the frequency and amplitude at that spot in the upper left corner of the 

display.  It should look a lot like this: 
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Using the Spectrum Analyzer 

If you look closely, you can see that there are actually four spikes and some random noise above 12,000 Hz.  We can 

remove specific frequency ranges with a Notch filter and we can remove that high frequency noise with our 

Continuous Noise filter or a Low Pass Filter.  So now we know all the basics to attack this problem – we’ll need a 

Harmonic Reject filter, 4 Notch filters and a Continuous Noise filter.    You can see how we used the tools to come 

up with a general plan of attack.  Now, close the Spectrum Analyzer. 

 

We have already created a Multi-Filter preset designed to clean this file.  Select the Multi-Filter preset called 

“Forensic Demo Clean Up Filter”.  Notice that our basic filter is not quite the same as we had set-up in the earlier 

analysis.  We know you want to hear this, so we will explain each component of this Multi-Filter preset after we 

listen to it in action.   

 

Note:  This is a computationally challenging filter.  Even a pretty fast computer might stutter or pause while trying 

to do all these calculations in real time.  If this happens just stop the preview.   Hit the Multi-Filter Preview button 

and listen.  Click bypass in and out a few times to get the full effect.  Cancel the Preview when you’re ready. 

 

Now click on Run Filter and listen to the resultant file in the Destination window.  This is almost as impressive; 

check out the before display in the Source window and compare it to the after waveform display in the Destination 

window.  It should look like this: 

 

 

The Power of the Multi-Filter is Obvious 
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Notice how the total jumble of noise in the source window has changed to a nice speech pattern in the destination 

window.   You could even make this a bit more “Hi-Fi” if you wanted, but the goal of most Forensic restoration and 

enhancement projects is to make speech understandable so that it can be transcribed. 

 

Now we will explain the filters we used in this preset.  Double click each filter as we explain it and examine the 

settings (each of these filters has its own tutorial in Section 2 of this Manual).  Close each filter when you finish 

looking at the settings. 

 

Brick Wall Filter – this is set to reject all low frequency sound below 135 Hz and all sound above 11 kHz.  

Remember the noise in the Spectrum Analyzer at 12 kHz and above?  We took it out with this filter. 

 

Harmonic Reject Filters – both are set to 60 Hz, which is a common power line induced noise frequency (50 Hz in 

many countries outside the US).  Why do we use two of them?  Because multiple filters of this type will deepen the 

attenuation of hum and buzz noise.  It’s like one worker digging a hole two feet deep and then another also digging a 

hole two feet deep, but the second worker starts in the hole created by the first.  You end up with approximately a 

four foot deep hole.   

 

Spectral Filter – Remember we thought we might need 4 notch filters?   We could have done that, but our Spectral 

Filter allows us to set up as many as 32,000 notch filters at once!   Additionally, this filter allows us to either boost 

or cut any frequency range we want including ones like these that are not related to each other harmonically.  This is 

just a more efficient way to handle several unrelated noises. 

 

Continuous Noise Filter – This filter is set up to aggressively filter just about all noise frequencies within the speech 

range.  Remember, this doesn’t take out all sound, but targets noise while leaving behind good audio.  It’s a good 

filter to add to the mix. 

 

Median Filter – This was chosen to add intelligibility to the voice.  It is good for enhancing muffled speech. 

 

Virtual Valve Amplifier - This will add harmonics to the voice, increasing intelligibility. 

 

Paragraphic EQ – This is set to raise the volume of the speech frequencies.   

 

So you see, we really did follow our initial path by using Harmonic filters, Notch filters and Continuous Noise 

filters.  We ended up adding some additional tools that further enhanced our audio.  You will likely do the same 

thing as you perform your own restorations.   This process of first planning a course of action and then making it 

better is a common one that you will use often. 

Close all filters, Make Destination the Source (saving it under a new name), and exit the program.   

Live-Mode Step by Step Guide 

 

This guide will introduce you to another major feature of the program.  As before, follow along with the included 

demo file and perform the actions printed in Bold type.  We assume you have mastered the other concepts we 

introduced in the Basic and Advanced audio restoration Step by Step guides.  Please make sure you have completed 

those earlier guides before attempting this one even if you are a Forensics User.  It teaches you the basic flow of the 

software program. 

 

Live-mode is a powerful feature of DCArt10 / DCForensics10 that allows you to remove noise and enhance audio as 

it happens.  You do not have to record the audio to the hard disk before applying filters.  Live Mode is used by TV 

and Radio broadcast engineers to clean up noisy live feeds for real-time transmission.  Forensics users use it to clean 

up real-time surveillance audio streams.  It is also useful for cleaning up radio reception for Hams, SWLs, DXers, 

and other Forensic applications.  Audiophiles sometimes use Live mode to replace the preamplifier and tone controls 

in their audio system.  If you have your computer connected to your home stereo, you can use Live-mode to actually 

restore your records while you play them.  It can also be used “on site” by Forensic users who may need to listen to 

(and record) surveillance audio as it happens. 
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To use Live-mode, make sure you have your speakers connected to the sound card output and an audio signal 

connected to the line level input.  This audio signal source can be from a soundboard, mixer, radio receiver (or 

tuner), turntable (with preamp) or any other signal.  For this Step-by-Step guide, we’re going to assume you are 

using a radio to provide a signal to the program.  In this case, you would connect the headphone or other audio 

output of your radio or tuner to the Line Input of your sound card.   

 

Turn on the radio and you should hear audio from the speakers connected to your computer.  This step depends 

somewhat on the brand and model of sound card that you have, but the great majority of sound cards will simply 

take whatever audio appears on its input and sends it directly to the output of the sound card.  If you don’t hear 

anything, just keep going in this Guide, as we’ll check everything out a bit later. 

 

Now turn off your Radio and launch the program if you haven’t already and then open the file called 

“Radiodemo.wav”.  It’s in the same directory as the other demo files.    Before we do this live, we’re going to 

experiment a bit with a recorded bit of audio.  

Once the file is loaded, listen to it.  You can hear that there is A LOT of noise in this file.  It is understandable, but 

would not be fun to listen to due to all the noise.  Once the file has finished playing, open the Multi-Filter (under 

the Filter Menu) and choose the preset called “Live Mode Demo Cleanup – SW Radio”.  This preset provides some 

useful tools for this demonstration file.  This preset will also be a good starting point for your own efforts as you use 

the program in Live mode. 

 

Double click the Continuous Noise Filter to open its adjustment window.  You can look at the settings for all the 

tools in the Multi-Filter preset and you should be able to understand what they are doing based on your learning so 

far.  Remember, you can always open a specific filter and then hit F1 to find out about it.  Your screen should look 

something like this: 

 

 

Multiple Screens Shown Working Together 

We want to bring your attention specifically to the Continuous Noise filter here because we are dealing with a 

concept that you might not have considered – How do I use this filter in Live mode when I can’t take a sample of the 

noise?   Remember, the audio is happening in real time and is typically not recorded to the disk at all in Live-mode.  

It’ll therefore be impossible under these conditions to actually take a noise sample.  Our preset setting here shows 

how you can deal with this.  Notice that the filter is set to provide a fairly large amount of attenuation to the low 

frequencies and the higher frequencies (remember, the higher the blue square controls are set, the more noise is 

removed at that frequency).  With radio signals, we will seldom care about very low or very high frequencies 

anyway, so this setting gets rid of a lot of noise without unduly bothering our good signal.  The controls between 

300 Hz and 3,000 Hz (which are speech frequencies) were then simply adjusted for good results.  Go ahead and hit 

the Multi-Filter Preview button now.  Click Bypass in and out to hear the improvement.  (Alternatively, change the 

CNF mode of the Continuous Noise Filter to Auto Spectrum CNF or AFDF and the filter will find its own noise 

fingerprint on-the-fly.) 
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Notice the slider labeled Attenuation.  This control determines the overall amount of filtering that is going on for 

the entire filter.  If you move this control upwards, it will filter more overall noise.  While Previewing, adjust the 

attenuation slider to find the point you like best.  You’ll find that this very weak signal is now quite understandable 

– if you speak German.  The other filters are also adjustable, of course.  You’ll quickly find that there is a tradeoff 

here.  The more aggressive you make the Continuous Noise filter, the more digital artifacts you will induce.  Just 

adjust it to please your ears. 

 

Now stop the Preview and let’s go into Live-mode.  Turn on your radio so that you can hear the signal in your 

computer speakers. 

Note:  If you don’t hear anything, continue on anyway as some sound cards don’t monitor incoming audio by 

default.  Double click the leftmost icon in the Multi-Filter so that you can adjust your audio settings.  Do that and 

then click on the button labeled “Live Preview” and the program will immediately start providing filtered audio to 

your speakers.  You should certainly be hearing audio now. 

 

In the Live-mode, your screen should look something like this figure: 

 

 

Live-Mode is engaged 

Important -- Do you hear two versions of the audio – one a bit later in time than the other - like an echo effect?  If 

so, you need to turn down the input of your sound card.  If you have a standard sound card, just double click the 

speaker icon in your tray and choose “Options” then “Properties”.  Now click on “Recording” and then click “OK”.  

Now move the slider labeled Line Input or Line down to the bottom.  The echo should go away!  If you have a more 

sophisticated sound card, refer to its documentation to find out how to turn off monitoring or turn down the Line 

Input control. 

 

If you have the DC Forensics10 version of the program, you cannot only process audio in real time, but you can 

record it as well.  Just click the Log to Disk button.  Additionally, you can also select VOX recording (the program 

starts and stops recording automatically with the signal that comes in) and have the program mark the segments with 

the date and time of their occurrence.   

 

Here’s a tip.  You can now add or change the filters as you please.  A good one for radio work is the Dynamic 

Processor using the ALC mode.  This can help a lot with atmospheric fading in a SW (Short Wave) signal as it will 

even out the audio level in real time.   

What you have learned: 

 

In this Step-by-Step Guide, you’ve learned how to use the Multi-Filter in Live mode to process audio as it happens.   

You’ve learned how to adjust your sound card for Live-mode – remember, however, that some low quality sound 

cards cannot record and play at the same time and therefore can’t be used in Live Mode.  You’ve also learned how 

some filters can be used to make radio reception much better. 
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Which Tool Do I Use? 

 
Probably the most frequently asked question we get each day is “How do I get rid of a certain type of noise?”  

Certainly, the more you use this product, the more proficient you’ll become at picking the right tool to match the 

noise you’re trying to remove.  But for now, if you’re new to the game, we’ve included this handy chart that may 

help you get a jump on finding the tools that match your problem areas.   

Filter Finder 

 
Sound Restoration 

Category 

 

Sound Defect or Task to be Performed 

 

Filter   Type 

Early Acoustical Cylinders 

and Discs 

"Pops" Impulse Noise (EZ-Impulse™ or Expert Impulse Filter) 

"Crackle" Average, Median or Continuous Noise Filter 

"Distortion" Low Pass Filter or De-Esser in the Dynamics Processor 

"Hiss" Dynamic Noise or Continuous Noise Filter 

"Rumble" Highpass or Continuous Noise Filter  

"Thin Sound" Graphic Equalizer 

"Reverse Skip" Cut 

"Forward Skip" Copy and Paste Insert 

Skip / Miss-tracking Speed Change Filter / Fractional Speed Mastering 

Cracked Record Big Click Filter 

“Thumps” 

 

Selective use of the High Pass Filter  

(set to 6 dB/Octave) 

“Off Pitch” Speed Change Filter 
 

 

LPs & 45 RPM Records "Ticks" Impulse Noise or EZ Impulse™  

"Pops" Impulse Noise or EZ Impulse™ 

"Distortion" Low Pass Filter or CNF in Artifact Suppression Mode 

"Rumble" High Pass Filter 

"Shrill" Graphic Equalizer 

"Reverse Skip" Cut 

"Forward Skip" Copy & Paste Insert 

Noise between Cuts or Tracks Dynamics Processor – Expander / Gate 

Muddy Bass on Stereo Records Channel Blender 

Stereo “Ping-pong” effect Channel Blender 

“Off Pitch” Speed Change Filter 

Magnetic Tape Recording "Hiss" Dynamic Noise Filter or Continuous Noise Filter 

“Highs Loss” Time Offset (azimuth correction) 

“Smeared” Stereo   Image Time Offset (azimuth correction) 

Clipping Distortion De-Clipper  

“Off Pitch” Speed Change Filter 

AM Radio, Short Wave or 

Transceiver Radio 

"Hiss" Dynamic Noise Filter or Continuous Noise Filter 

“Static” Impulse Noise (EZ-Impulse™ or Expert Impulse Filter) 

Line Frequency “Buzz” Harmonic Reject Filter 

Volume Fading Dynamics Processor ALC 

Heterodyning “Whistle” Notch Filter or Multiple Notch Filters 

AM Broadcast "Whistle" Notch Filter (Europe - 9 kHz) 

(US - 10 kHz) 

Line Frequency Buzz Harmonic Reject Filter 

Volume Fading Dynamics Processor ALC 

  

FM Stereo Broadcast Multi-path Distortion Dynamics Processor / De-Esser or Channel Blender 

Multiplex Noise Channel Blender 

Ignition Noise / Static Impulse Noise Filter 

"Feedback" Notch Filter 

"Hum" Notch Filter 
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"Mic 'P' Pop" Hi-Pass Filter 

"Dead" Dynamic Noise Filter (spectral enhancement mode) 

‘Digital Sound” Virtual Valve Amplifier / Tube Warmth 

Street Noise CNF Spectral Subtraction 

HVAC Noise CNF Spectral Subtraction 

Hum Notch Filter 

Buzz Harmonic Reject Filter or EZ Impulse 

Sibilant “Ess” De-Esser 

Digital Clipping Limiter Preset in the Dynamics Processor 

Telephone Conversation "Intelligibility" Bandpass Filter  

“Noisy - Random Out of Band” Brick Wall Filter in Bandpass mode or Band Pass Filter in 

Chebyshev Mode  

"Noisy – In Band" Continuous Noise Filter 

"Muffled or Garbled" Median Filter or Spectral Inverse Filter 

Variation in loudness between parties (near party/ far 

party gain compensation) 

Dynamics processor / Compressor / ALC  

 

Punch and Crunch in ALC mode 

 

Cell Phone Noise Interference Cell Phone Noise Filter 

Surveillance Recording Cancellation of Radio / or TV using a reference track File Conversions (Left – Right Mode) 

 

Adaptive Filter in Reference Mode 
Dynamic Spectral Subtraction filter (DSS) 

Automatic Voice Activated Recording Multi-Filter operating in VOX mode 

 

 Automatic Time Activated Recording Timer Recording Function 

Noise isolation & identification 
 

Poor Speech Articulation  

Slot Filter 
 

Median Filter w/ Weighting 

Varying Random Noise Profile Adaptive Filter 

Varying Coherent Noise Profile like music playing 
behind speech 

Continuous Noise Filter in DSS Mode with reference track  

DTMF Tone Amplification DTMF Presets found in the Paragraphic EQ 

DTMF Tone Identification Spectrum Analyzer 

Voice Masking Speed Change + Stretch & Squish Filters 

 

Voice Disguising Voice Garbler 

Forensics Audio Analysis & 

Enhancement 

 

 

 

Gunshot Ballistic Timing Markers and Time Display / Spectrum Analyzer 

Gunshot Ballistic Identification Matching Time Display and Spectrogram  

Voice Identification Spectrogram or Voice ID 

 

Analog Tape Deck Azimuth Correction Time Offset Adjustment in the File Converter 

 

Person Talking too fast for Transcription 
 

Poor Intelligibility 

Stretch & Squish 
 

EZ Forensics 

Spectral (Inverse) Filter 

Voice Pitch too High Speed Change Filter 

Tape Authenticity Spectrum Analyzer 

 

Reference Channel Acoustical Compensation Bandpass Filter plus 20 Band Equalizer plus Reverb 

Poor Intelligibility 20 Band Graphic EQ 

Adaptive Noise Rejection AFDF in the Continuous Noise  

Filter 

Adaptive Filter under Forensics Menu (TDAF) 

Very weak party or sounds in the background Whisper Enhancer (Forensics Menu – Forensics Version only) 

Narrowband Noise Rejection 

De-Muffling           

30 Band EQ 

Spectral Inverse Filter or Overtone Synthesizer 
 

Optical Movie Soundtracks "Pops"  Impulse Noise 

"Crackle" Median or Crackle Filters 

"Thuds"  Highpass Filter 

"Hollow" Graphic Equalizer 

“Film Flicker” Harmonic Reject Filter 

  

Television / Video Vertical Sync Pulse Bleed-through buzz Harmonic Reject Filter –  
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30 Hz United States 

25 Hz Europe 

Horizontal Sync Pulse Bleed-through 
 

Low Pass Filter 
 

Any Sound Source Mike “P” Pop Highpass Filter selectively applied 

Low Gain or Volume Gain Change (under Edit menu) 

Acoustical Feedback 

Clipping Distortion 

Notch or Harmonic Reject Filter 

De-Clipping Filter or Manual De-Clipping Process or 
Lowpass Filter selectively applied or Impulse Filter 

 

De-Ess (excessive sibilance of the pronunciation of 
the letter “S.”) 

Lowpass Filter selectively applied, or use the Dynamic 
Processor/ De-Esser 

Pitch incorrect Change Speed Filter 

Wind Noise Wind Noise Filter 

Whisper among louder noise Whisper Enhancer  

Line Frequency “Buzz” Harmonic Reject Filter or Narrow Crackle Filter 

Excessive Dynamic Range Dynamics Processor or Punch & Crunch 

Lacking Dynamic Range Dynamics Processor or Punch & Crunch 

Top Octave missing Virtual Valve Amplifier / Harmonic Exciter  

Top Octave Weak 
 

Dynamic Noise Filter Enhancer Mode 
 

Bottom Octaves Missing Sub-harmonic Synthesizer 

Recording lacks “warmth” 

Top Octave Missing 

Virtual Valve Amplifier 

Overtone Synthesizer 

Too much Reverb Continuous Noise filter/Channel Blender (Blend to Mono) 

Weak Vocal Gain Change selectively applied 

No Ambience Reverb 

Digital Clipping De-Clipper 

Analog Clipping De-Clipper 

Harmonic Distortion Polynomial Filter / De-Esser 

Inter-modulation Distortion Polynomial Filter 

Multi-Tone Whistle Spectral Filter or Multiple Notch Filters 

Signal Over modulates Limiter Presets in Dynamic Processor 

Noise Between Tracks or Rides Noise Gate Presets in Dynamics Processor 

Automatic Noise Reduction EZ Clean™ Filter 

Sterile Bass Sound VVA Fat Bass 

Medium Resolution  Frequency Contouring 20-Band Graphic EQ 

 High Resolution Frequency Contouring 30-Band Graphic EQ 

Normalize Loudness Between Multiple Wave files 
 

Auto Leveling in the Batch File Processor 
 

EQ Matching Spectral Filter operating in Spectral Difference Mode 

Occasional Spurious Noises Manual Interpolate using the “I” key or “O” key 

 Line Frequency “Buzz” Harmonic Reject Filter or Impulse Filter 

 Turntable Rumble Dynamic Bass Processor 

 HVAC Random Noise Dynamic Bass Processor 

 Bass Enhancement Dynamic Bass Processor 
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For more information, please go to support@diamondcut.com or call us at 973-316-9111.  We also host a user 

forum having about 30,000 posts that includes an effective search engine located here: 

 
https://www.diamondcut.com/vforum/ 

 

Demo versions of our software are available from our software store located here: 

 
https://www.diamondcut.com/st3/product-category/software/ 
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